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OnColor QC – Quick Start Instructions 

A complete OnColor User’s manual is included on your installation CD.  It was 
copied to your hard drive during installation of the software.  Look for the MS 
Word document called “OnColor Manual v5x.doc”.  The latest feature additions 
are described in the document called “Release Notes.doc”. 

 

OnColor QC Overview and Quick Start: 
 

1. Follow the instructions to install the OnColor software that came with your 
software package.  You need to attach the Hardlock key to either the USB 
port or the parallel port on your computer, depending on which configuration 
your software was shipped with.  Start the OnColor software by double-
clicking on the icon on your desktop that looks like this: 

 
2. You will see a splash screen of the OnColor logo followed by the default User Screen.  

The default User Screen will look similar to this for spectrophotometers: 
 

 

3. For colorimeters such as the CR-400 or CR-300 series, the default screen only shows 
two of these quadrants. 

4. Before you can begin taking measurements with your color instrument, you must connect 
the instrument to a serial port on the computer and establish communications.  See the 
section below on “Establishing Communications with your Color Instrument”. 
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5. Calibrate your instrument according to the section below entitled “Instrument Calibration”.  
Your instrument manual will give you detailed instructions on how and when to perform 
correct calibration.  To start the calibration procedure in OnColor, simply type “C” or click 
on the Calibrate icon on the tool bar.  If you need to change the set-up of the instrument, 
go to Options  Instrument Settings.  See the section below for more detail. 

6. You are now ready to begin taking measurements.  You must always start by declaring a 
Standard.  To measure a Standard, type “S” on the keyboard or click on the Measure 
Standard icon on the tool bar.  Enter a name for this color and then position the sample at 
the measuring port of the instrument.  Press “Enter” or click on the OK button to initiate 
the reading. 

7. You will see the addition of the measurement data to the User Screen. 

8. To compare another sample to this Standard, you will designate it as a Trial.  To measure 
a Trial, type “T” on the keyboard or click on the Measure Trial icon on the tool bar.  Enter 
a name for this sample and then position it at the measuring port of the instrument.  
Press “Enter” or click on the OK button to initiate the reading. 

9. You will see the addition of the measurement data to the User Screen and will note that 
the data for the Trial is compared to the Standard and color difference is calculated. 

10. You can continue measuring other samples as Trials against this Standard.  OnColor will 
handle an unlimited number of trials to one Standard.  Use the  and  arrow keys on 
the keyboard to scroll through the different Trials. 

11. You can save this data to a file by clicking on File  Save.  The data is then saved to a 
save-set file.  See the section below on Save-Set files for more description. 

12. To enter a new Standard, click on File New to open a new document.  Follow steps 6 – 
11 above to measure a new set of samples. 

 

 

About Report Properties 
 
Depending on the level of OnColor license that you have obtained, up to six different report 
screens are available to display your color data.  You can 
change from one report to another by clicking on any of the 
following icons on the tool bar. 
 
The look and layout of each Report screen can be changed or customized to your preferences.  
The design of each screen is saved into a template called a Report Property.  This template or 
.PRP file does not change or affect your data.  It only changes how and where it is displayed on 
the various Report screens.  The Save-set or WSV file contains the actual data. 
 
You can create and store as many templates or PRP files as you can imagine, but the most 
important one is the one called STARTUP.PRP.  This template is the one that is applied every 
time OnColor is started.  It is the default property file.  You can make changes to the lay-out or 
template and save them by going to Report  Save Properties As and then saving your new 
design as STARTUP.PRP.  Or, you can give it a different name and apply this template by 
clicking on Report  Recall Properties and then selecting the name of the PRP file that you gave 
it. 
 
One item that you will want to change immediately in all Property files is your company name and 
address.  This is changed by clicking on File  Page Setup.  Enter the new information for your 
company name, address, and comment and then make the change permanent by saving your 
STARTUP.PRP file again. 
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As a general rule, you can change any item or “setting” on the report screen by double-clicking 
directly on the object that you want to change.  For example, to change the Color Space or 
Illuminant or Observer, double click on the item that you want to change.  This will bring up a 
Properties dialog box where you can make your new selection.  To change the lay-out of the 
screen, double-click on a blank area of the screen and the appropriate dialog box will appear 
where you can change the lay-out of that report screen.  This applies not only to the User Screen, 
but also to all other Report Screens.  Double-clicking on the name of the Standard or Trial will 
bring up an Edit dialog where you can change the name or other data associated with this 
measurement. 

On the tool bar, you can also click on this icon to change the Report Properties:   
 

OnColor Navigation Aids 
 
Once you have calibrated your instrument and measured a few samples into a Save-Set, it’s easy 
to navigate through OnColor.  Several Navigation Aids are available to streamline the use of 
OnColor. 
 
1. Use the  and  arrow keys on the keyboard or on the toolbar to scroll through 

the different Trials. 
2. Right click on any screen to bring up a shortcut menu for the most common 

options.  On the QC Report screens, this includes these options: 
3. On the Color Plot or Spectral Plot report screens you can use the Zoom 

features to zoom in or out on any portion of the graph. 
4. Display the name of any Standard or Trial by gliding the mouse over that point. 
5. Double click on any data point to bring up the Edit dialog box where you can 

change it. 
6. Double click on any graph to bring up the change Properties dialog box where 

you can configure the type of data that you want to display. 
7. All of these options are also available via the Menu options. 
8. Use the Keyboard Shortcuts described below to get single keystroke access to the most 

commonly used commands. 
 

Keyboard Shortcuts: 
 
OnColor allows the user to create and modify existing keyboard short cuts.   These short cuts can 
be modified or viewed by selecting 
 
ViewKeyboard Shortcuts.  Select a Menu option from the alphabetical list and then click on 
Create Shortcut.  Type the shortcut key that you wish to assign and then click OK. 
 
OnColor comes pre-configured with a few basic shortcut keys.  You can add to these or modify 
them to suit your application: 
 
C = Calibrate S = Standard Measure   T= Trial Measure 
D = Database of Standards F1 – Help    F2 = Standard Save 
F3 = Trial Save F4 = Standard Recall   F5 = Trial Recall 
F6 = Search 
 
You can set-up your own short-cut keys to further customize OnColor for your application and to 
streamline your procedures. 
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Establishing Communications with your 

Color Instrument  
1. Make sure your Spectrophotometer or Chroma 

Meter is turned on and attached to the serial port 
and then launch the OnColor program. 

2. Go to Options and select Communications.  The 
following text box will appear.  

3. Select your Instrument type from the Instrument 
list. Click on Test settings. 

4. A text box will appear telling you if you have 
successfully communicated with your instrument. 

 

 

 
Hints and Reminders: 
1. OnColor recognizes Com1-4.  Make sure your 

instrument is on the correct Com port. 
2. If you can’t establish communication and you feel that all the parameters are correct try 

toggling the power on the Spectrophotometer and hit test settings again. 
3. An in depth discussion and troubleshooting guide for establishing Communication can be 

found in OnColor help.  This topic is found by selecting the help drop down menu, index, and 
finally select the topic “establishing communication with a spectrophotometer.” 

4. Demo mode is the default mode when no instrument is connected to the software.  Always 
insure that the proper instrument communication is established.  The instrument type 
currently active is displayed in the bottom right corner of the OnColor program.   

 
 
 

Instrument Calibration:  
 
Quick Steps: 
1. Type the letter “C” and the instrument settings text box will appear. 
2. Make sure the default settings are selecting the calibration parameters you want. 
3. Simply type the letter “C” again and the software will ask you to perform a zero or black 

calibration. 
4. If your instrument is equipped with a black trap position the trap over the instrument port and 

hit ok. 
5. The software will then ask you to perform a white calibration.  Position your white tile over the 

instrument port and hit ok. 
6. The software will give a successful calibration message. 
 
Hints and Reminders: 
1. The instrument settings allows a user to change the area of view, Specular component, and # 

of flashes per measurement. 
2. For a detailed description of the Instrument settings options look under the help Index and 

selecting the following string of topics: Help, Index, Options menu, Calibration, and 
Instrument Calibration and setup dialog.  
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Instrument Settings: 
 
Quick Steps: 

1. Go to Options  Instrument Settings. 
2. A dialog box similar to the one at the right will allow you to change the set-up conditions 

for your instrument.  Not all options are available for all instruments. 
3. Select the conditions for measurement and then click OK or click on Calibrate to proceed 

with the calibration procedure. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Hints and Reminders: 
 
1.  An Instrument status code appears in the lower right corner of the screen.  It is composed of 
three boxes; in the left and right boxes you will find a 6-letter code. The code in the left box refers 
to the instrument conditions under which the current standard was measured.  The code in the 
right box refers to the current conditions of the instrument. In the center box the instrument model 
appears.  If the instrument is set to Demo Mode, then the computer is NOT communicating with 
an instrument and you need to go to Options  Communications to establish communications 
with your instrument.  
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Instrument Status Codes 
 

Position Letter Meaning 
 

1 B 
C 
H 
K 
L 
X 

100% Line Calibration 
Ceramic Calibration 
Hitch Calibration 
Keyboard Input 
Low Illumination Calibration 
Not Calibrated 

2 R 
T 

% Reflectance 
% Transmission 

3 I 
E 
B 

Specular Component Included (Gloss Included or SCI) 
Specular Component Excluded (Gloss Excluded or SCE) 
Both SCI and SCE 

4 A 
E 
F 
G 
I 
P 
Q 
R 

Extra Filter 
UV Component Excluded  
UV Component Excluded w/420nm Cutoff 
UV Component Excluded w/400nm Cutoff 
UV Component Included 
Partial UV 
Partial UV w/420nm Cutoff 
Partial UV w/400nm Cutoff 

5 L 
M 
S 
V 

Large Aperture lens setting (LAV) 
Medium Aperture lens setting (MAV) 
Small Aperture lens setting (SAV) 
Very Small Aperture lens setting (VSAV) 

6 L 
M 
S 
V 
P 

Large Area of View mask (LAV) 
Medium Area of View mask (MAV) 
Small Area of View mask (SAV) 
Very Small Area of View mask (VSAV) 
Petri Dish Accessory (CM-3500d only) 

 
Hints and Reminders: 
 
1. When recalling a standard always check the instrument status box to the left of your 

instrument type; this displays the instrument status originally used to measure the standard. 
2. Always compare a standard to a trial with the same instrument status. 

 

Tool bar icon descriptions: 

 
The toolbar is displayed across the top of the application window, below the menu bar.  The 
toolbar provides quick mouse access to many tools used in OnColor and Colorant Analysis.   
 

 
Icon descriptions: (listed left to right) 
 
1. Open a new data file. 
2. Open an existing data file. 
3. Save the active data file. 
4. Opens print dialog box. 
5. Print preview the active data file. 
6. Context sensitive help. 
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7. Show the next trial. 
8. Show the previous trial. 
9. Calibrate. 
10. Measure  Standard. 
11. Measure Trial. 
12. Show the notes for the current standard. 
13. User Report screen.* 
14. Color Plot Report. 
15. Data Table Report * 
16. Spectral Plot Report.  & 
17. Tolerance Plot Report * 
18. Statistics Report * 
19. Change the report properties. 
 
*  These features are not available with the Lite version of OnColorQC. 
& These features are not available with the Colorimeter version of OnColorQC. 
 
Hints and Reminders: 
1. Drag the mouse on top of an icon and a label will be displayed with a brief description of the 

icon. 
2. Further descriptions of the toolbar options can be displayed in help.  Select the index option 

and type in the word toolbar and display the help file regarding the toolbar. 
 

Report Screens: 
 
OnColoQC offers the user six different “Report Screens” or  views selectable from the toolbar.  
These reports offer a wide variety of display options and can be customized by selecting the 
property icon and  defining conditions in the text box that is displayed.  The six screen views are: 

 

1. User Screen:   The user-defined report screen is the default screen that 

appears when the program is accessed.  It divides the screen into four 
quadrants, and each of the quadrants can be customized using the properties 
icon. 

 

2. Color Plot:  This screen displays a plot of the active datafile in a color space.  

The user has the option to change color space equations, scale, trial markers, 
etc. 

 
 

3. Data Table:  This screen displays a spreadsheet-like table of the 

colorimetric and color difference data.  Color patches, assessments, indices, 
and job tags can be included. 

 

4. Spectral Plot:  This screen view displays the active datafile’s standard and 

trial reflectance data.  As with all the screen views the user can manipulate the 
screen by selecting the properties button on the toolbar. 

 

5. Tolerance plot:  This screen view displays a graphical representation of the 

numerical values which define a range of color variation between samples 
which is considered acceptable. 

 
 

6. Statistics plot:  This screen is a histogram of the active datafile with multiple 

graphs displaying colormetric values such; delta L, delta A, and delta B. 
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Hints and Reminders: 
1. All of the screen views are selectable from the toolbar. 
2. The user can customize the active screen view by selecting the property button on the tool 

bar. 
3. A detailed description of the customizable options available for each screen view can be 

found in the help index. 
 

OnColor Help: 
 
OnColor contains a online help file that is extremely extensive and covers a wide range of topics 
and information.  The help  file can also be found as a word document in the 
\OnColor\Documentation folder on your hard drive or on the OnColor CD.  The online help can be 
accessed from the help drop menu.   Additional documentation is also found in the 
\OnColor\Documentation folder. 
 
 
Hints and Reminders: 
1. For directions on using the help select the option using help found under the help drop menu. 
2. OnColor help offers detailed step by step outlines of almost every function in the OnColor 

program. 
 

Using the OnColor Database of Standards 

 
A very powerful feature of OnColor is the Database of Standards.  This option is used to store 
reflectance data and tolerances for standards and formulas.   You will have the ability to: Search 
for closest match, Recall Standard, Recall Trial, as well as to “filter” your searches or recalls for a 
particular “system”.  The Database of Standards is stored as a Microsoft Access MDB file.  This 
file type is ODBC compatible and can be read using MS Access.  This file structure is very useful 
for networked applications and for viewing data in real time.  The most difficult task in OnColor is 
creating this database.  Following exactly the steps below will get you through this process 
quickly.  Using the database for storing, recalling, and searching is easy from there. 
 
To Create a new Database of Standards: 

1. Select File, then Database of Standard or type the shortcut key “D”.  When selected 
it may take several seconds to load the current file.  The first screen is the Transfer 
Tab.  This lists the current database loaded, the records stored in the database, the 
current Save Set and the standard and trial(s) in the Save Set.  The Search Tab is 
used set the parameters for the search routine. 

2. Select the <Open> button.  This puts you in the Select Data Source window.  Stay in 
the File Data Source tab.  Select what directory you wish to store the new file.  Go 
into “Look in” and bring up the directory name.  Click on the New button. 

3. The next window is Create New Data Source.  The Microsoft Access driver (*.mdb) 
should be highlighted, click on <Next>.  

4. The next window is still Create New Data Source.  This is where you type in the 
name of the link (*.dsn) you want designated.  Click on <Next>. 

5. The next window tells you that you just created the filename (which is your *.dsn file).  
Click on <Finish>.  Now we will begin to build the database file (*.mdb). 

6. The next box to pop up is the ODBC Microsoft Access  Setup.  In the Database 
section, click on <Create>.   

7. This command puts you in the New Database window.  Make sure you are in the 
right directory.  Under Database Name, type in the name of your database (*.mdb), 
and click on <OK>.   

8. The next dialogue box should say the Database C:\CyberChrome Color 
Systems\Wmatch\*.mdb was successfully created. You will click on <OK>. 

9. Click <OK> again to exit out of ODBC Microsoft Access  Setup. 
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10. In Select Data Source window you will see the *.dsn file in the main box.  Click on the 
newly created *.dsn file.  The name will appear in the DSN Name box.  Select <OK> 

again. 

11. In the next window you have the option to select what additional data you want to 
store in the database.  Click on Tolerances to save the pass/fail tolerance criteria for 
each standard; click on Formula Data to save formulas (colorants and amounts) for 
each standard; or click on Delta Data to save color difference data, assessments, 
indices and pass/fail rating.  Any combination of these three can be selected.  The 
option must be selected at this time and cannot be added later.  The more options 
selected, the larger the database will be.  The Formula Data option is available only 
on matching packages. Click  <OK> to continue. 

12. The database will load.  This may take a few seconds.  After the database has been 
loaded, you will see the file you created listed under Current Database.  When you 
click on <OK>, the database window will close but the database remains the active 

one and is noted on the Status Bar in OnColor. 

13. You can now transfer reflectance data to the database from any of the active save-
sets by clicking on the standard or trial and then clicking on the left arrows. 

14. After making color matches and you wish to store the formula into the database, 
Select Match on the menu bar, then click on Save Formula. The current formula will 
be stored in the new database (*.mdb) you just made.  Note: any formula saved will 
always be stored in the last or current database in Database of Standards. 

 
To Open an existing Database of Standards: 
 

1. Select File and Database of Standards.  When selected it may take several 
seconds to load into the option.  The first screen is the Transfer Tab.  This lists the 
current database loaded, the records stored in the database, the current Save Set 
and the standard and trial(s) in the Save Set.  The Search Tab is used set the 

parameters for the search routine. 

2. Select the <Open> button.  This puts you in the Select Data Source window.  Stay in 
the File Data Source tab.  Select which directory where the (*.dsn) file is located.  Go 
into “Look in” and bring up the directory name.  Click one time on the desired *.dsn 
file.  The name will appear in the DSN Name box.  Select the <OK> button to load 

the database.  This may take a few seconds. 

3. After the database has been loaded, you will see the file you created listed under 
Current Database.  When you click on <OK>, the database will close.  You are ready 

to store reflectance data or the match formulas in the current *.mdb file. 

4. The name of the current Database of Standards in shown in the Status Bar in the 
lower right portion of the screen (next to the name of the current Property file). 

 
To store and recall data into the Database of Standards: 

1. Go to File, then Database of Standards, or use the hot key “D”. 

2. On the right side of the Transfer window are listed the standard and trials in the 
current save-set (WSV file).  Use the left and right pointing arrows to copy records 
from one file to the other.  The procedure works both ways. 

3. You can also recall something from the Database using the menu commands 
StandardRecall or Trial Recall. 

4. Similarly, you can save a sample to the Database using the menu commands 
StandardSave or Trial Save. 

 
To Search the Database of Standards: 

1. Open a new save-set and measure the target color to be searched for as a Standard. 

2. Click on Trial Search.  The program searches the database for the “n” closest 
shades that are within a certain DE as specified in the Search Tab of the Database 
of Standards.  For example, the program returns the 5 closest shades that are less 
than 10DE from the Standard.  They are reported as Trials in order from lowest DE to 
highest DE.  The criteria for the Search are set in the Database of Standards 
Search Tab.  If “Database Filtering” is checked to ON, then the list of records in the 
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database will be filtered accordingly.  In order to use filtering, you must either have 
the Alternate Name field and/or System fields populated.  The System field is 
generally set-up to indicate the product line, but it could also be used to enter the 
customer or any other criteria that is useful to search on. 

3. Alternately, you can go to File, then Database of Standards, or use the hot key “D”. 

4. Click on the Search button.  The program searches the database for the “n” closest 

matches to the Standard in the current save-set, same as indicated above. 

 
To Use Database Filtering: 

1. The Database can be “filtered” according to the Alternate Name, System, or date and 
time.  The date and time of measurement is always tagged with each reading.  The 
Alternate Name and System are fields that must be input at measurement time or else 
edited later. 

2. “Systems” are entered by going to FileList Management and then selecting the List 
of Systems Tab.  You can Add, Edit, or Delete system names here.  Same for Jog 

Labels, although you can’t use job labels to filter the database. 

3. If you have populated at least some of the records in the Database of Standards with 
Alternate Names or Systems, then you can turn on “filtering” on either the Transfer tab or 
the Filter tab in the Database of Standards window.  You can also turn on or off filtering 
when you do StandardRecall or TrialRecall. 

4. When “Filtering” is turned on, then only those records that meet the filter criteria will be 
listed or searched. 

 
To Recall a Standard with a Stored Formula: 

1. If you have the Matching version of OnColor, then formulas can also be stored with each 
Standard in the Database of Standards.  A formula is stored in the database by going to 
MatchSave Formula after doing a match.  The current formula displayed on the 
screen is saved.  This can come from a combinatorial match, a single match, manual 
match, or the New Formula after a batch correction.   

2. To recall a Standard with a Stored Formula, first you must be certain that the proper 
colorant file (.CLR) is the current active file.  The easy way to do this is to recall a PRP 
file that references this CLR file.  Then go to StandardRecall and choose the desired 
standard from the list.  If a formula exists for this standard and the correct colorant file is 
active, then the formula is recalled along with the Standard color data.  If the correct 
colorant file is not open on the active save-set, then the Standard color data is recalled 
without a formula. 

 
Saving the Trial Delta Data to the Database of Standards 

1. If the option to save Trial Delta Data was selected when the current database of 
standards was created, then an additional table exists in the MS Access MDB file where 
color difference data, assessments, pass/fail, and indices are stored.  See step 11 above 
in Creating a New Database of Standards.  This data is stored for as an output table only.  
This data cannot be recalled with OnColor because it is dependent on what standard was 
active at the time the trial data was saved.   

2. The purpose of this additional table is to provide for real time report generation using the 
ODBC capability of the Access database.  Anyone on a network can view this Access 
MDB file in real time to query the database.  They do not need to have an OnColor 
license to do this.  Management and production reports can be generated from this file on 
a real time or as needed basis. 

3. To save the trial color difference data to the Access Database of Standards, click on 
TrialSave or use the Database of Standards Transfer window to move a group of 
trials to the database.  When using the Trial Save option, the current trial is copied to 
the current database along with its color difference data for three illuminants, job ID’s, 
assessments, pass/fail, and indices.  The name of the current Standard is also stored 
with this record. 

4. The Trial data can be recalled into either the Standard or Trial position.  This will recall 
the %R data, but it will not recall the stored delta data since this is calculated based on 
the active standard.  The Trial Delta data can only be read using MS Access. 
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Menu Options:  
The following sections give a brief overview of all of the other Menu options available in 
OnColorQC.  For a detailed description of how to use these features, go to the complete OnColor 
Manual found on your installation CD or your hard drive.  The file name is: 

 OnColor Manual V5x.doc 

 

  

The File menu offers the following commands: 

 

New   Opens a New *.WSV saveset file or *.CLR database file 

Open Opens an Existing *.WSV saveset file or *.CLR database file 

Close  Closes the Active *.WSV saveset file 

Save    Saves the active *.WSV data file using its current name and path 

Save  Saves the active66 *.WSV data file to a specific file name and path 

Workspace   Pop-up menu with Workspace Options 

Database of  Section where the formulas are stored 

Copy to  Copies all records in the current WSV file to the current Database of 
Standards 

List Management  Create and edit the lists for Systems and Job ID’s 

Security    Password protected files for managers and workers 

Spreadsheet.   Export the current data to a spreadsheet format 

Send Mail  Sends the active file using E-Mail 

Print  Prints a report of the current data 

Print Preview  Displays the report of the data on the screen, as it would appear printed 

Page Setup    Sets the margins and font for the printout 

Print Setup   Selects a printer and printer connection 

Print Label Selects a label template and prints a label on a Dymo Label printer 

Exit   Exits OnColor 

Recent Files  -1, -2, -3, -4  Opens the most recent WSV files listed 
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The Standard Menu offers the following commands: 

 

Measure    Measures the standard with the instrument. 

Average    Averages a number of scans to comprise one standard measurement. 

Keyboard    Input of standard values via the keyboard. 

Edit    Edits the standard name, % reflectance and colorimetric data. 

Null   Enters a null standard 

Save   Saves the current Standard to the current Database of Standards 

Recall    Recalls a Standard from the current database. 

Most Popular  Polls all trials to determine which standard they are closest to in a multi-
standards file 

Utilities   Options to copy, delete, find, select/deselect, and sort the standard data 

Download    Downloads the current standard into the portable instrument 

Upload    Uploads target and/or trials from the portable instrument. 

Switch    Exchange standard with current trial position. 

Average  Trials   Average all trials to replace current standard. 

Auto Naming  Toggles auto naming of the trials on/off 

Position    Enable/disable use of sample previewing mirror with CM-3500 before 
measurement. 

Naming Options  Naming options for standard name. 

Multi Standards  Mode allows for multiple standards to be managed in a save-set (WSL 
file) 

Multiple Standards  Selects the standard to be used for display purposes 

 

 

The Trial menu offers the following commands: 

 

Measure    Measure a trial with the instrument. 

Average    Average a number of scans to comprise one trial measurement. 

Keyboard   Input of trial values via the keyboard. 

Edit    Edit the trial name, % reflectance and colorimetric data. 

Recall    Recalls a trial from the current database 

Search.   Search for closest match to standard from database of standards. 

Utilities   Options to copy, delete, find, select/deselect, and sort the trial data 

Auto Naming    Toggles auto naming of the trials on/off  

Insert Mode   Inserts the next trial in this position. 

Position    Enable/disable the use of the sample previewing mirror with the CM-
3500 before measurement. 

Auto-Select Standard    Search for closest standard within all opened save sets. 

Auto_Save    Automatically saves a measured trial to an existing file. 

Naming Options    Naming options for trial name. 
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The Report menu offers the following commands: 

 

User Defined  Displays the user defined screen. 

Color Plot    Displays the color plot screen. 

Data Table   Displays the data table screen 

Spectral Plot   Displays the spectral plot screen. 

Tolerance Plots   Displays the tolerance plot screen. 

Statistical Charts   Displays the statistical charts screen. 

Properties    Change the properties (screen layout) for the active report. 

Save Properties As   Save all report properties (screen layouts) and current options for  later 
recall. 

Recall Properties   Recalls a PRP or property files and sets all report properties (screen 
layouts) according to this template 

 

 

The Options menu offers the following commands: 

 

Macro   Macros are used to perform a series of operations in one keystroke. 

Averaging   Pre-select a fixed number of measurements to average or set the 
minimum   and maximum number to average, or set a fixed time 
between measurements. 

Tolerances   Select to view or edit box tolerance, elliptical tolerance, or for 
PASS/FAIL assessment. 

555 Block Sizes   Select to do shade sorting. 

Observer / Illuminants   Select illuminants and observer. 

Color Space   Select the color space shown on output. 

Indices   Select which indices are displayed. 

Opacity / Reflectivity   Performs opacity/reflectivity measurement. 

Haze / diffuse 

Transmittance   

Performs haze calibration and haze measurement. 

Measure Background    Changes the white and black background when using Haze or 
Opacity options. 

Gloss Correction   Applies a gloss correction to each measurement that is taken   

Calibration    Calibrates the instrument  

Instrument Settings   Selects the SCI/SCE; aperture and mask; UV energy settings, etc. 

Calibration Interval   Select to enter in the time interval for instrument calibration. 

Remote Measurement   Waits for the Measure Button to be triggered on a portable 
instrument rather than via the PC 

Communications   Change or test instrument communication 

 



OnColor Match Quick Start Guide 
 

16 

 

The View Menu provides the following options: 

 

Toolbar   Show or hide the toolbar. 

Status Bar   Show or hide the status bar. 

Keyboard Shortcuts   Create shortcut keys that accesses menu commands. 

Default Directories      Displays the file type and directory path as selected. 

Select Font   Select the display font. 

Select Colors   Select display colors. 

Calibrate Color Patches   Select to calibrate the color patches on screen. 

Previous Standard   Scroll to display values for previous Standard in a multi-
standards file 

Next Standard   Scroll to display the data for the Next Standard in a multi-
standards file 

Previous Trial   Scroll to display values for previous trial. 

Next Trial   Scroll forward to display values for next trial. 

Previous Meas. Status   Displays the data for the previous status on a multi-status file 

Next Meas. Status   Displays the data for the next status on a multi-status file 

Measurement Status 

Sequence   

Selects which measurement statuses are displayed in a       
multi-status file 

Display Notes  Displays the notes associated with the Standard and Trials. 

Zoom   Uses the zoom feature to zoom in, zoom out, or return to the 
default position on graphs 

 
  

The Window menu offers the following commands: 

 

New Window   Creates a new window that views the same document.  Use this command 
to display more than one report screen at a time. 

Cascade   Arranges windows in an overlapped fashion. 

Tile   Arranges windows in non-overlapped tiles. 

Arrange Icons   Arranges icons of closed windows. 

Window 1, 2,   Selects the window to become active in the foreground. 

 

The Help menu offers the following commands: 

 

Index    Offers you an index to topics on which you can get help. 

Help Topics   Provides a Table of Contents and easy acces to Help 

Using Help    Provides general instructions on using help. 

About    Displays the version number of this application. 

CyberChrome 

On the Web 

Provides a link to the CyberChrome web site for sales, support, and other 
services options 
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OnColor Match – Quick Start Instructions 
 

A complete OnColor User’s manual is included on your installation CD.  It was 
copied to your hard drive during installation of the software.  Look for the MS 
Word document called “OnColor Manual v5x.doc”.  The latest feature additions 
are described in the document called “Release Notes.doc”. 

 

This manual is a supplement to the OnColor QC Quick Start Guide and covers 
the additional features of Color-Matching and Batch Correction.  Please read the 
QC Guide before beginning here. 

 

OnColor Match Overview 
When launching OnColor Match Gold, you will see three additional icons on your toolbar for the 
formulation options.  The Menu bar and Tool bar will look similar to this: 
 
 

 
 
The additional icons are for the following Report Screens: 

 
 
Colorant Characterization Report 
 
 
 
Match Report 
 

 

 

Batch Correction Report 
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Color-Matching 
1. Before doing a computer color-match you must have a colorant file (CLR) loaded.  The 

CLR file contains the data on your colorants, pigments, or dyes as characterized in your 
product. If you do not have a colorant file, then you must either load one or obtain one 
from a master source (such as your supplier, your R&D or technical department, etc.) 

2. After you have your colorant file loaded and/or stored on your computer, you should set 
up a Report Property file (.PRP) that calls up this colorant file and selects the other 
matching parameters.  Go to the Match Report   or configure the User screen to have the 
Match Report in one of the quadrants.  Several matching .PRP files are included with 
OnColor.  Pick the one closest to your application (such as COATINGS.PRP, 
PLASTICS.PRP, TEXTILES.PRP, etc) and use it as a template to customize it for your 
colorant file and your application parameters. 

3. To configure the Matching parameters, double-click in the Match Report to bring up the 
Formulation Properties dialog box.  The Style tab controls the type of information 
displayed on the screen.  The Select tab allows you to pre-select a colorant file (CLR) 
and the colorants you want to use for matching; and the Numeric tab allows you to enter 
the Batch Size, units of weight or volume, math type, number of colorants in the match, 
and the DE limits for the matches.  Enter your desired application parameters to 
customize it for your needs. 

4. After selecting all of these matching parameters, save these settings as a Report 
Property file (PRP).  To do this, click on Report Save Properties As, and then select a 
path and filename.  If you save this as your STARTUP.PRP file, then these will be the 
default settings whenever you launch the program. 

 

3 Easy Steps to Do a Color Match 
 

1. Recall the Report Property file that contains the matching parameters that you want to 
use if it is not already active. 

2. Type “S” to measure the color to be matched into the Standard position or recall it from a 
file. 

3. Type “M” to do a combinatorial match. 
 

 
 
 
 
All possible matches that 
meet the match criteria are 
sorted by a weighted DE and 
displayed.  The Best Match is 
shown as Trial #1.  The 
second best match is shown 
as Trial #2, etc.  Use the  
and  arrow keys to scroll 
through the possible 
matches. 
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TIP:  Right click in the Match quadrant to display a shortcut menu where you can:  Sort the 
matches by cost; Sort them by DE; Save the Formula to the Database of Standards; or change 
the Match Report Properties. 

 
Select the match that best meets your criteria of metamerism, cost, and pigment selection.  Save 
the formula to the Database of Standards (Match  Save Formula or right click in the Match 
quadrant) for easy recall at a later time in case you need to do a color correction to this match.  A 
typical user screen showing the results of a match prediction is shown here. 
 
 
 

Batch Correction   
 
OnColor contains powerful color correction routines that help you correct the color of a laboratory 
hit or production batch.  Just as with the Matching options, it is advisable to set up a Report 
Property file specifically for doing batch correction.  This PRP file would pre-select the colorant 
file, batch type, and numerical match parameters for the correction, allowing you to recall all of 
these setting with a single mouse click.  Go to the Batch Correction Report or configure the User 
screen to have the Batch Correction Report in one of the quadrants. 

 
 

4 Quick Steps to Do a Batch Correction 

1. Recall the Batch Correction Report Property file (PRP) that you created. 

2. Recall the Standard from the Database of Standards (Standard  Recall, then select it 
from the list).  This will also recall the colorants and the formula if you stored it.  If you did 
not store the standard, measure it now. 

3. Measure the batch to be corrected as a Trial by typing “T” on the keyboard.                              

4. If you recalled the formula along with the Standard from the database, then type “B” to 
perform the batch correction.  If you did not store the first hit in the database, then go to 
Correct Input Batch Amounts and enter the amounts for each colorant. 

The “Add” to be made to the 
batch is shown in the Batch 
Correction Report along with 
the starting formula and the 
final formula after the add is 
made.  Depending on the 
parameters chosen, 
correction factors and the % 
change to each colorant are 
displayed.  Changes to the 
output to this screen made on 
the Style tab of the Batch 
Correction Report dialog box.  
You can easily change these 
properties by double-clicking 
in the Batch Correction 
quadrant and going to the 
Style tab. 

 

The “New Formula” (the way 
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to make the corrected color from scratch or reformulation of this color) is displayed in the 
Match Report.   A typical User Screen showing the Batch Correction Report and the New 
Formula is shown here. 

 

Other Batch Correction Options 
 

 

 

 

 

 

TIP:  Right click in the Batch Correction quadrant to get this 
short-cut menu of options for manipulating the add and 
calculating alternative corrections. 

 
 
 

Under the Batch Correction Menu you will find additional post-processing options to: 
1. Save the Formula after the add – This will store the Standard color along with the batch 

formula after the add to the Database of Standards.  If you need to do another correction, 
recalling this information will load the correct colorants and current amounts in the batch 
into the correction routine. 

2. Manual Add – allows the operator to zero out the automatic computer add and then enter 
his idea on amounts to be added to correct the batch.  The color difference data is 
displayed for the new proposed correction.  One or more colorants can be added at the 
same time.   

a. If you want to do a Manual Add, click on Correct Manual Add or use the right 
click in the correction quadrant to access the shortcut menu. 

b. Use the Zero Add button to set all of the add amounts to 0.0. 
c. Enter the amounts that you want to use and click on APPLY to see the change in 

the DE.  Click OK when you are satisfied with your add. 
3. Reduce Add – asks the correction routine to find a minimum add to get to an offset DE.  

The operator selects a DE greater than zero and the software will attempt to add the 
minimum amount of colorant to get to this DE.  The automatic correction routine always 
attempts to adjust the batch to zero DE. 

4. Optimize Add – provides an option to see if the batch can be corrected to an acceptable 
DE by adding the “optimal” amount of one colorant.  The operator zeros out the automatic 
computer add and then selects a colorant that he thinks will correct the batch.  The 
computer then predicts the optimal add of that colorant along with the resulting DE.  The 
operator can use this feature in succession with more than one colorant. 

a.  If you want to Optimize the Add, click on Correct Optimize Add or right click in 
the Correction quadrant and select Optimize Add. 

b. Click on “Zero Adds” button and note that all adds were set to zero and the DE 
returns to the original numbers (or very close). 

c. Click into the Add Amount column for the colorant that you want to Optimize, 
then click RUN.  See the effects on the DE on the screen. 

d. If you want to Optimize another colorant, click into the add amount column for 
that colorant and hit Run again or you can Zero the Adds and start over again. 

5. Change Correction Factors – allows the operator to change the correction factors that are 
applied to the add.  This alternate correction factors can come from known strength 
information or from other successful adds.   

6. How to Add a Colorant to the Batch for Manual Add:  Follow these steps to add a fourth 
colorant to the batch for the purpose of making a manual add.   
1. Do a Batch Correction with 3 colorants 
2. Get your answer displayed on the screen, then double click in the Correct quadrant to 

bring up your Batch Correction Properties. 
3. Go to the Manual tab and then select the Manual Add option. 
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4. Change the # of colorants to 4. 
5. Select the 4th colorant using the drop down list.  This will be in the next to last slot.  

Remember that the White must be in the last slot. 
6. Your add amounts in the boxes should equal the add amounts that are on the 

screen. 
7. If you want to zero out the existing add, do it now. 
8. Then, enter the desired add amount of the 4th colorant and hit Apply to see the effect 

on the DE. 
 

Loading a Colorant Database 
 
Detailed steps for characterizing a colorant database are given according to application type in 
the full OnColor manual.  Recommendations for the proper samples to prepare can also be found 
here.  The scope of this topic is too lengthy for this Quick Start Guide.  Please consult the full 
manual for these instructions or contact your OnColor applications expert to help you.             
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